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ABSTRACT: 

One of the most common and dreaded problems in Marine propeller are high levels of 

vibration. In this paper we focus onto reduced vibrations in a marine propeller blade. 

Propellers with conventional isotropic materials create more vibration and noise in their 

operation. It is undesirable in strength point of view. In the present study vibrations 

generated in propeller blade are reduced by using FLD technique. In FLD, the 

viscoelastic materials are coated on the marine propeller blade such as Natural, Neoprene 

and Nitrile rubbers. Modal analysis is performed on marine propeller blade by using 

ANSYS WORKBENCH 18.1 and designing is carried with SOLID WORKS 2013*64 

and KATIA V5 soft wares . 
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CHAPTER I 

1 INTRODUCTION 

Vibration is a mechanical phenomenon whereby oscillations occur about an 

equilibrium point. The oscillations may be periodic, such as the motion of a pendulum or 

random, such as the movement of a tire on a gravel road. 

In many cases, however vibrations undesirable, wasting energy and creating unwanted 

sound. The vibrational motions of engines, electric motors, or any mechanical device in 

operation are typically unwanted. Such vibrations could be caused by imbalances in the 

rotating parts, uneven friction, or the meshing of gear teeth.  Careful designs usually 

minimize unwanted vibrations. 

1.1 Types of vibrations  

1.1.1 Free vibration: 

 It occurs when a mechanical system is set in motion with an initial input and allowed to 

vibrate freely. The mechanical system vibrates at one or more of its natural frequencies 

and damps down to motionlessness. 

1.1.2  Forced vibration:  

It is when a time-varying disturbance is applied to a mechanical system. The disturbance 

can be a periodic and steady-state input, a transient input, or a random input. The periodic 

input can be a harmonic or a non-harmonic disturbance. 

1.1.3  Damped Vibration:  

When the energy of a vibrating system is gradually dissipated by friction and other 

resistances, the vibrations are said to be damped. The vibrations gradually reduce or 

change in frequency or intensity or cease and the system rests in its equilibrium position. 

1.2  Important Terms of Vibration: 

1.2.1  Frequency:  

Frequency means the number of times that vibrating object generates a repetitive motion 

in 1 second 

1.2.2  Displacement:  

Disaplacement means the amplitude (distance) between the peaks of vibration. 
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1.2.3  Velocity: 

 Velocity means the changing rate of displacement to time. 

1.2.4  Acceleration: 

 Acceleration means the changing rate of velocity to time. 

1.3  Vibrations in Machines: 

1.3.1  Vibrations in Automobile: 

 Vibrations in engine are generated due to the reciprocating mechanism used for 

converting the energy into rotary motion. The forces producing the engine vibrations are 

Combustion, Reciprocating and Rotational Forces. A downward force is generated during 

combustion stroke on the piston which due to geometrical construction of connecting rod 

and crankshaft generates a torque around crankshaft axis. Torsional vibrations are 

generated due to the torque variations. A multi-cylinder engine can be compared with a 

system of masses rotating on single crankshaft in single and different planes. The primary 

&secondary forces as well as couples generate vibrations due to reciprocating unbalance. 

Significant inertia effects are generated due to small unbalance of rotating masses in high 

speed engines. Rotating unbalance generates unacceptable levels of vibrations and stresses 

in individual and supporting structures. 

1.3.2  Vibrations in Aerospace: 

 The majority of troublesome vibrations in aircraft arc forced vibrations, due to 

periodically varying forces originating in or around the power plant; the only important 

type which is not due to such a cause is flutter. Flutter is a vibration in a part of the aircraft 

structure set‐up by turbulence in the slipstream passing over the part, and has been the 

subject of a good deal of investigation from the early days of flying up to the present time. 

Control surfaces appear to be particularly susceptible to flutter, but a really spectacular 

example of mechanical failure from this cause is to be found in another branch of 

engineering—the failure of the Tacoma Bridge in America. In this case a suspension 

bridge, with a half‐mile central span, was completely wrecked by the effects of turbulent 

flow. 
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Fig. 1.1 Flutter Excitation 

1.3.3  Vibrations in Marine Structures:  

Vibration ships are majorly categorised into two types, depending on the components 

of the ship the vibration is primarily related with. They are: 

a) Machinery Vibration 

b) Hull Vibration 

1.3.3.1  Machinery Vibrations:   

The vibrations that originate due to the operation of machinery can be listed under 

Machinery Vibrations. Any machinery that have parts moving at a certain frequency 

induce vibrations. So, main engines, propulsion shafts, gearboxes, propellers, pumps, 

diesel generators- all machinery transmit vibrations. 

The role of a ship designer is to first understand how each of this machinery causes 

vibrations, and then device methods to keep them within safe levels. Machinery Vibrations 

can again be categorised into three types, depending on the nature of the vibrations: 

• Torsional Vibration 

• Axial or Longitudinal Vibration 

• Lateral Vibration 

1.3.3.1.1 Torsional Vibration: 

The main propulsion system of a ship consists of the main engine, which is 

connected to a propeller by a shaft. The shaft is again, not a single component. Usually, a 

marine shaft consists of an intermediate shaft and a propeller shaft, which are connected 

by means of coupling flanges. The presence of connections, like coupling flanges, thrust 

block, engine connection flange, and the cylinder piston system in the main diesel engine 

creates torsion in the rotating shaft system. In other words, the rotatory motion of the diesel 
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engine creates an ‘excitation’. So, the entire propulsion system can be simplified, for 

vibrational analysis into a series combination of shafts and discs, as shown in the figure 

below: 

 

Fig. 1.2 Main Propulsion system as a combination of shafts and discs. 

  The above system of shafts and discs deduced from the proposed propulsion system 

of a ship to be designed, is used to calculate the natural torsional frequency of the 

propulsion system. The task of a designer is to choose a main engine such that the natural 

frequency of the main engine at its MCR is not within 5% of the natural torsional frequency 

of the entire propulsion system. Or in other words, the approach can be reasonably 

generalised stating that, the excitations should be minimised so as to prevent resonance. 

According to the speed range at which torsional resonance occurs, the barred speed range 

is set, so that this speed range is avoided during voyage. If that is not taken care of, it 

would result in a torsional failure of the shaft. 

1.3.3.1.2 Axial or Longitudinal Vibration: 

One of the most interesting cases of machinery vibration, and perhaps the one most 

likely to cause forced vibrations, is axial vibration of the propulsion system. As we saw 

earlier, to analyse a case of vibration, it is important to identify the excitation of a particular 

type of vibration. Axial mode of vibration makes the propulsion system behave like a 

horizontal multiple degree of freedom spring-mass system. So, the above propulsion 

system can be reduced to a system as shown below. 
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Fig. 1.3 Multiple DOF Vibration System of Propulsion System 

  Now, for a while, let us shift attention from this system and focus on the operation 

of the propeller. The thrust generated by the propeller depends on the velocity of water 

incident onto the propeller blades (called wake). Now, due to the curvature of the hull at 

the aft, the wake on the propeller is not uniform in nature. That is, the wake at the top of 

the propeller disc is different from the wake at the bottom of the disc. 

 

Fig. 1.4 Variation of wake on a propeller 

 

It shows the variation of wake at different angles around the propeller disc. This 

diagram is only for a particular distance from the centre of the propeller disc (shown in 

blue). So it should be well understood, that the wakes for each distance from the centre of 

the propeller centre will have different graphs. 
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When a particular blade of the propeller is at 0 degree position, the velocity of 

water onto it is different from the velocity of water onto the same blade when it has rotated 

to 90 degree position and this variation is continuous across one half of the propeller 

rotation. As a result of this, the thrust generated by that blade at zero degree position will 

be different from the thrust generated by the same blade at 90 degree and 180 degree. And 

this is repeated with each revolution, which means that the thrust generated by the propeller 

is periodic in nature, which we often call as alternating thrust. A periodic thrust becomes 

the exciting force for the axial vibration of the propulsion system. 

The frequency of the propeller excitation is (Propeller RPM x Number of blades). 

In order to avoid resonance, the designer must ensure that the first few natural frequencies 

of axial vibration of the main propulsion system (shown in figure 2) is at least 5% away 

from that of the propeller excitation frequency. 

In such a case, there are two major options. One, either the propeller excitation 

frequency needs to be changed, or the natural frequency of the main propulsion system has 

to be altered.  

Changing the propeller excitation frequency: 

In order to change the propeller excitation frequency, either the number of 

propeller blades has to be changed, or the rated RPM of the propeller has to be altered. 

Changing the number of propeller blades is not a feasible option because the number of 

blades has a high influence on the efficiency of the propeller. At this stage of the design, 

the rated RPM of the propeller has already been decided upon on the basis of required 

torque and thrust to provide the effective power required by the ship. So, altering the rated 

RPM is not a viable option either. It is clear, Option One cannot be implemented. 

Changing the natural frequency of Main Propulsion System: 

The natural frequency of any system depends on the stiffness and the mass of the 

system. Changing the mass of the propulsion system is not an intelligent approach. Instead, 

ship designers focus on playing with the stiffness of the system. The foundation of the 

thrust bearing is the component that deflects in response to the thrust that is transmitted by 



14 

 

the thrust bearing. In other words, it behaves as a spring. So the structural foundation of 

the thrust bearing must be redesigned to obtain a stiffness that would change the natural 

frequency of the propulsion system to the desired value. 

1.3.3.1.3 Lateral or Transverse Vibration: 

This mode of vibration occurs in the direction perpendicular to the axis of rotation 

of the shaft. The intermediate and tail shafts can be considered as beams, with the shaft 

bearings as support points. 

Due to bending of the shafts, the centre of gravity of the shaft does not coincide 

with the ideal centreline of the shaft, therefore when the shaft rotates, the centrifugal force 

on the centre of gravity would cause it to shift further away from the ideal centreline, 

resulting in a vibratory motion called whirling of shafts. The number of shaft bearings and 

the distance between them is the deciding factor in the occurrence of this mode of 

vibration, during the design phase. 

 

Fig. 1.5 Effect of Bending on motion of a shaft 

 

Care is to be taken by the designer that the natural frequency of lateral mode of 

vibration of the shaft does not coincide with the natural frequency of the engine. In such a 

case, resonance would result in extreme case of whirling, which would lead the shaft to 

snap and cause damage or accidents. Also, when the engine of a ship is started, and its 

speed gradually increased, there comes a point when one would feel maximum vibrations 

on the ship for a few moments. That is because, there during the speeding up, there arrives 

a point at which the RPM of the engine coincides with the natural whirling frequency of 

the shaft. Such a speed / RPM is to be carefully avoided. This speed is called Critical 

Speed, or Barred Speed Range. A ship is never to be operated at this speed range, and 

during speeding up, this speed range should be passed as quickly as possible so as to 

prevent prolonged shaft vibrations. 
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1.3.3.2  Hull Vibrations:  

Hull vibrations include vibration of main hull, sub structures (such as deck house, uptakes, 

masts, deck, bulkheads, etc.) and local structures (such as panels, plated and minor 

structure members). 

 

Fig. 1.6 ship hull and propeller 

Vibration Suppression Methods: 

Vibration suppression is the practice of using damping, isolation or a cancellation 

solution to reduce or eliminate vibrations that would otherwise result in loss of 

performance or limit the useful life of a system. 

Different techniques of vibration control 

a) Isolation 

b) Absorption  

c) Damping  

1.4  Isolation: 

       Isolation is often an effective means of vibration suppression when there is a limited 

path for transmission from a vibrating structure to a sensitive component, or from a noisy 

component to the rest of the system. Vibration isolation is how you isolate an object, such 

as a piece of equipment, from the source of the damaging vibrations.  

https://www.sorbothane.com/vibration-damping.aspx
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A vibration isolator takes mechanical energy out of the system so it’s no longer a 

concern – therefore suppressing vibration and potential damage to the system. 

 

1.4.1 Fig. 1.7 Isolation of a machine 

1.4.2 Common passive isolation systems: 

1.4.2.1 Pneumatic or air isolators: 

These are bladders or canisters of compressed air. A source of compressed air is 

required to maintain them. Air springs are rubber bladders which provide damping as well 

as isolation and are used in large trucks. Some pneumatic isolators can attain low resonant 

frequencies and are used for isolating large industrial equipment. Air tables consist of a 

working surface or optical surface mounted on air legs. These tables provide enough 

isolation for laboratory instrument under some conditions. Air systems may leak under 

vacuum conditions. The air container can interfere with isolation of low-amplitude 

vibration. 

 

1.4.2.2 Mechanical springs and spring-dampers: 

These are heavy-duty isolators used for building systems and industry. Sometimes 

they serve as mounts for a concrete block, which provides further isolation. 

1.4.2.3 Pads or sheets of flexible materials such as elastomers, rubber, cork, dense foam and 

laminate materials: 

Elastomer pads, dense closed cell foams and laminate materials are often used 

under heavy machinery, under common household items, in vehicles and even under 

higher performing audio systems.  
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1.4.2.4 Molded and bonded rubber and elastomeric isolators and mounts: 

These are often used as machinery mounts or in vehicles. They absorb shock and 

attenuate some vibration. 

1.4.3 Negative-stiffness isolators: 

Negative-stiffness isolators are less common than other types and have generally 

been developed for high-level research applications such as gravity wave detection. Lee, 

Goverdovskiy, and Temnikov (2007) proposed a negative-stiffness system for isolating 

vehicle seats. 

The focus on negative-stiffness isolators has been on developing systems with very 

low resonant frequencies (below 1 Hz), so that low frequencies can be adequately isolated, 

which is critical for sensitive instrumentation. All higher frequencies are also isolated. 

Negative-stiffness systems can be made with low stiction, so that they are effective in 

isolating low-amplitude vibrations. 

Negative-stiffness mechanisms are purely mechanical and typically involve the 

configuration and loading of components such as beams or inverted pendulums. Greater 

loading of the negative-stiffness mechanism, within the range of its operability, decreases 

the natural frequency 

1.5  Absorption: 

Absorbing sound spontaneously converts part of the sound energy to a very small 

amount of heat in the intervening object (the absorbing material), rather than sound being 

transmitted or reflected. There are several ways in which a material can absorb sound. The 

choice of sound absorbing material will be determined by the frequency distribution of 

noise to be absorbed and the acoustic absorption profile required. 

1.6  Damping: 

    A common approach to vibration suppression is adding damping. Vibration 

damping dissipates some of the vibration energy by transforming it to heat. By 

selecting the right vibration damping material you can suppress or 

eliminate noise and vibration in industrial, electronic, structural and ergonomic 

applications caused by vibration and damaging resonance. 

 

 

https://www.sorbothane.com/energy-absorbing-material.aspx
https://www.sorbothane.com/vibration-damping-material.aspx
https://www.sorbothane.com/noise-control.aspx
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1.6.1 Structural damping : 

Structural damping is a particular common pattern for how the damping in a solid 

material when it flexes depends on frequency. Specifically, the damping factor, which tells 

how many radians of phase the restoring force lags behind the displacement, is 

independent of frequency over a wide range. It's not mathematically possibility for it to be 

constant over all frequencies because that would violate   but it can be and often is constant 

over many orders of magnitude if it rolls off at both ends. That means structural damping 

gives more damping at low frequencies than viscous damping, where the damping force 

and the damping factor are proportional to frequency. Viscous damping is much easier to 

treat mathematically, so it gets a lot more textbook pages, but it's only useful for fluids and 

is typically quite unrealistic for solids. 

 

Fig. 1.8 Structural damping 

Viscous damping:  

Free vibration (no external force) of a single degree-of-freedom system with 

viscous damping can be illustrated as, 

 

Fig. 1.9 Viscous damping 
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Damping that produces a damping force proportional to the mass's velocity is commonly 

referred to as "viscous damping", and is denoted graphically by a dashpot. 

1.7  Damping treatments: 

They are two types of damping treatments  

• Free layer damping treatment  

• Constrained layer damping treatment 

1.7.1  Free layer damping treatment: 

 A free layer damping treatment is formed by applying a coating of a high damping 

material to one or both sides of a structure. If the coating is perfectly bonded to the 

structure, the coating may be taken as being subjected to the strain at the interface between 

structure and coating. Consequently, the dominant component of strain is tensile.  

Free layer treatments may be symmetric (identical coatings on both sides of the 

structure), or asymmetric (one side only), and applied to beams, plates or shells in bending 

or in tension. Two classes of treatments are of interest, those employing thin coatings of a 

relative stiff damping material, and those employing thick coatings of a relatively soft 

material. 

 

Fig. 1.10 Free layer damping treatment 

 

1.7.2  Constrained layer damping: 

 

In the constrained layer damping technique the damping material is bonded to the 

structure similar to the free layer damping technique, then an another constraining layer 

having very high stiffness is constrained over the damping material. 
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Fig. 1.11 Constrained layer damping 

1.8  Types of rubbers used as damping layers: 

1.8.1 Natural rubber: 

It is also called india rubber as initially produced, consists of polymers of the organic 

compound isoprene, with minor impurities of other organic compounds plus water. 

Malaysia is one of the leading producers of rubber. Forms polyisoprene that are used as 

natural rubbers are classified as elastomers 

Natural rubber is used by many manufacturing companies of the production of rubber 

products. Currently, rubber is harvested mainly in the form of the latex from the rubber 

tree. The latex is a sticky milky colloid drawn off by making incisions into the bark and 

collecting the fluid in vessels in a process called (tapping). 

The latex then is refined into rubber, ready for commercial processing. Natural rubber is 

used extensively in many applications and products, either alone or in combination with 

other materials. 

 

 

 

 

1.8.2  Nitrile rubber: 

It is also known as Buna-N-, Perrbunan, Acrylonitrile butadiene rubber And NBR, is a 

synthetic rubber copolymer of acrylonitrile (ACN) and butadiene. 
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Nitrile butadiene rubber (NBR), is a family of unsaturated copolymer of 2-propenenetrile 

and various butadiene monomers. Although its physical and chemical properties vary 

depending on the polymer’s composition of nitrile, this form of synthetic rubber is unusual 

in being generally resistant to oil, fuel and other chemicals.  

1.8.3 Neoprene rubber:  

It is the family of synthetic rubbers that are produced by polymerization of chloroprene. 

Neoprene exhibits good chemical stability and maintains flexibility over a wide 

temperature range. Neoprene is produced by free-radical polymerization of chloroprene. 

In commercial production, this polymer is prepared by free radical emulsion 

polymerization. 

In this present work, we opted a Marine propeller blade which is a type of fan that 

transmits power by converting rotational  motion into thrust. A pressure difference is 

produced between the forward and rear surfaces of the aerofoil-shaped blade, and a fluid 

(such as air or water) is accelerated behind the blade. The modes of vibration of a propeller 

blade, beyond the fundamental and first torsional and flexural modes, are extremely 

complex. 

 This complexity arises from the non-symmetrical outline of the blade, the variable 

thickness distribution both cordially and radially and the twist of the blade caused by 

changes in the radial distribution of pitch angle. 

 In addition, the effect of the water in which the propeller is immersed causes both 

a reduction in modal frequency and a modified mode shape when compared with the 

corresponding characteristics in air. 

 To introduce the problem of blade vibration it is easiest to consider the vibration 

of a symmetrical flat blade form in air because, in this way, many of the practical 

complexities are eliminated for a first consideration of the problem. 

 

  

https://en.wikipedia.org/wiki/Mechanical_fan
https://en.wikipedia.org/wiki/Rotational
https://en.wikipedia.org/wiki/Thrust
https://en.wikipedia.org/wiki/Airfoil
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CHAPTER II 

2 LITERATURE REVIEW 

 

2.1  INTRODUCTION 

Before going with the project a brief study on papers related to Vibration Analysis is done. 

Many authors give different ideas related to their works on the analysis of the Damping 

Treatment for Vibrations. 

Pavol Lengvarsky, Jozef Bocko, Martin Hagara’s discussed  about “Modal 

Analysis of Titan Cantilever Beam Using ANSYS and Solid Works”. In this paper are 

given basic steps of the modal analysis simulation. The modal analysis is carried out on 

the titan cantilever beam. The cantilever beam is designed in the graphical environment of 

the ANSYS and Solid Works. The cantilever beam was fixed on one end and all degrees 

of freedom on this end were taken, beam cannot move and rotate. Mode shapes and natural 

frequencies are computed in programs ANSYS and SolidWorks with numerical 

formulation of the direct solver including the block Lanczos method.   

S.Abdul Mutalib, S.Suresh, and S.Jaya Kishore discussed about “Design and 

Analysis of  Marine Propeller using ANSYS Workbench”  present work progress a 

methodology to design a propeller with isotropic material such as aluminium and 

composite materials to analyze its strength and deformation using ANSYS 

WORKBENCH software. To compare the effectiveness of aluminum metal and composite 

material such as CFRP and GFRP, static analysis and dynamic analysis are performed on 

these different materials. The solid model of marine propeller is developed using Solid 

works. This works approach the substantial improvements in metal propellers. The 

stress,strain and the total deformation were found out both the aluminium and the 

composite marine propeller using ANSYS. The stresses obtained are well within the limit 
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of elastic property of the materials. The results are compared with aluminum and marine 

propeller for the maximum stress and maximum deformation. 

 

Palle Prasad, Lanka Bosu Babu’s discussed about “Design And  Analysis Of The 

Propeller Blade” the increased need for the light weight structural element with acoustic 

insulation, has led to use of fiber reinforced multilayer composite propeller. The present 

work carries out the structural analysis of a CFRP (carbon fiber reinforced plastic) 

propeller blade which proposed to replace the Aluminum propeller blade. Propeller is 

subjected to an external hydro static pressure on either side of the blades depending on the 

operating depth and flow around the propeller also result in differential hydrodynamic 

pressure between face and back surfaces of blades. The propeller blade is modeled and 

designed such that it can with stand the static load distribution and finding the stresses and 

deflections for both aluminium and carbon fiber reinforced plastic materials. This work 

basically deals with the modelling and design analysis of the propeller blade of a torpedo 

for its strength. A propeller is complex 3D model geometry. This requires high end 

modeling CATIA software is used for generating the blade model. This report consists of 

brief details about Fiber Reinforced Plastic materials and the advantages of using 

composite propeller over the conventional metallic propeller. By using ANSYS software 

static structural analysis are being carried out for different methods. 

Nicholas J.Oosting ,Julie Hennessy ,David T.Hanner,Dave Fang, discussed about 

“Application of a Constrained Layer Damping Treatment to a Cast Aluminium V6 Engine 

Front Cover” Constrained Layer Damping (CLD) treatments have long provided a means 

to effectively impart damping to a structure [1-3]. Traditionally, CLD treatments are 

constructed of a very thin polymer layer constrained by a thicker metal layer. Because the 

adhesion of a thin polymer layer is very sensitive to surface finish, surfaces that a CLD 

treatment can be effectively applied to have historically been limited to those that are very 

flat and smooth. New developments in material technology have provided thicker 

materials that are very effective and less expensive to apply when used as the damping 

layer in a CLD treatment. This paper documents the effectiveness of such a treatment on 

a cast aluminium front cover for a V6 engine. Physical construction of the treatment, 

material properties and design criteria will be discussed. Candidate applications, the 

assembly process, methods for secondary mechanical fastening will be presented. Noise 
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and vibration data from both bench testing and engine dynamometer testing will also be 

presented. 

The data collected on this engine cover has shown that the new damping material 

can function very well in a constrained layer damping treatment on a cast engine cover. 

Because of its thickness, it is particularly suited to cover surfaces that are rough and 

uneven. The design flexibility of the material makes it easy to optimize for a variety of 

covers an surface geometries. Bench testing on other types of cast components, such as 

valve covers and oil pans, have also shown very promising results 

Mohan D.Rao discussed about “Automotive applications of viscoelastic damping 

treatment” Fifth international congress on sound and vibration In this paper, the 

application of passive damping technology using viscoelastic damping materials to control 

noise and vibration in vehicles is described. Special damped laminates suitable for mass 

production and capable of forming with conventional processes are now manufactured in 

a continuous manner using the coil coating laminating process. These are widely used in 

the automotive industry in a variety of applications to reduce noise and vibration and to 

improve interior sound quality. The increased use of this technology illustrates that it is 

now one of the important tools available to solve many NVH problems in vehicles in a 

cost-effective way A final note about the use of passive damping technology. They are 

recommended for use in structural components that are not primaty load carrying 

members, For load carrying members, the design should first satisfy the strength and 

stiffness requirements over damping benefits. 

Dzmitry Tsetserukou, Naoki Kawakami, Susumu Tachi discussed about 

“Vibration Damping Control of Robot Arm Intended for Service Application in Human 

Environment” Ieee-Ras International Conference on Humanoid Robots The paper focuses 

on vibration damping control of a new anthropomorphic robot arm enabling the torque 

measurement in each joint and tactile area recognition to ensure safety while performing 

tasks of physical interaction with environment or human beings. The vibrations in heavily 

loaded joints have risen due to compliances introduced into each joint of the robot arm by 

means of torque sensors. Such oscillations deteriorate the performance of the manipulator 

and present undesirable disturbance during interaction with human beings. In order to 

overcome this disadvantage we have proposed robust technique allowing considerable 

reduction of the oscillation amplitude through acceleration signal feedback. The detailed 
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design procedure of the lead controller enabling improvement of transient response is 

presented in the paper. The experimental results of vibration damping control show the 

feasibility of proposed approach to suppress the oscillations of compliant robot joint. 

The flexibility of robot joint caused by compliant elements, such as torque sensors, 

harmonic drives, and lightweight mechanical connectors, produce significant effect on the 

dynamics of robot. The presented experimental results prove oscillatory behaviour of 

joints of whole sensitive robot arm. To compensate flexibility effect, first, we elaborated 

the dynamic model of the robot joint as two-mass system. The system with lead 

compensator and angular position of the load feedback is proposed to dump undesired 

vibrations. The oscillation parameters required to design the lead controller were 

determined by using experimental data and analytical equations. The experimental results 

show high performance of the developed controller in terms of successful damping of 

vibrations. In the future research we will address the tasks of implementation of vibration 

damping in each robot joint and realization of adaptive compensator to adjust parameters 

according to the effective inertia can be observed in the shape of the output responses, 

from the results obtained from the simplified input 

V.R.Navale, Dr.C.L.Dhamejani discussed about “Torsional Vibration In Engine 

and use of viscous damper”. Aim is takes part in torsional vibration theory and their 

practical experiences used in dampers which are widely used in automobile application & 

civil applications. This report paper highlights a number of important considerations for 

the torsional viscous damper system as well as design philosophies to assess and mitigate 

the risk of torsional failures. Damping properties are of significant importance in 

determining the dynamic response of structures, and accurate prediction of them at the 

design stage, especially in the case of lightweight, wind-sensitive buildings, is very 

desirable. Unfortunately, damping parameters cannot be deduced deterministically from 

other structural properties and recourse is generally made to data from experiments 

conducted on completed structures of similar characteristics. Such data is scarce but 

valuable, both for direct use in design and for furthering research into the phenomenon of 

damping. So use of damper is very much useful to reduce the torsional vibration. So 

viscous damper is mostly use for this purpose 

From the above theory and observation its very much useful to damper assembly 

in engine to reduce the vibration..The absence of damper most is needful to improve the 
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engine life & reliable system. Again say that viscous damper is best solution for damping 

and to absorb the vibration. 

 P.Jaenker, V.Kloppel, P.Konstanzer, R.Maier Eads, discussed about “Piezo Active 

Vibration and Noise Control In Helicopters” 26th International Congress Of the 

Aeronautical Sciences The reduction of noise and vibration is still a major task of 

helicopter development. Comfort, safety and environmental friendliness are key drivers of 

current active system research projects of EADS and its business unit Euro copter. Main 

focus of the research is on reducing rotor induced vibrations and. The paper reports on 

recent advances on i) vibration and noise control at the rotor, ii) vibration and noise control 

at the transmission and iii) vibration and noise control at the fuselage. Emphasis is placed 

on the reduction of rotor- induced vibrations and noise which is still the key challenge in 

developing the” jet smooth ride helicopter”. A set of technologies have been developed at 

EADS and its business unit Euro copter to improve comfort, safety and environmental 

friendliness of future helicopters. Several systems arose from an intensive active system 

research program and these technologies are applicable also for other EADS products like 

commercial a/c. The systems developed are demonstrated in flight test and in carefully 

designed laboratory experiments. It has been proved that a significant reduction of rotor 

and gearbox induced vibrations and noise can be achieved. Thus, we took a significant 

step toward the” jet smooth ride helicopter”. 

T.Subramani, K.Udhaya Kumar discussed about “Damping Of Composite Material 

Structures with Riveted Joints”  International Journal Of Modern Engineering Research 

(IJMER) Vibration and noise reduction are crucial in maintaining high performance level 

and prolonging the useful life of machinery, automobiles, aerodynamic and spacecraft 

structures. It is observed that damping in materials occur due to energy release due to 

micro-slips along frictional interfaces and due to varying strain regions and interaction 

between the metals. But it was found that the damping effect in metals is quite small that 

it can be neglected. Damping in metals is due to the micro-slips along frictional interfaces. 

Composites, however, have better damping properties than structural metals and cannot 

be neglected. Typically, the range of composite damping begins where the best damped 

metal stops. In the present work, theoretical analysis was done on various polymer matrix 

composite (glass fibre polyesters) with riveted joints by varying initial conditions. Strain 

energy loss was calculated to calculate the damping in composites. Using FEA model, load 

variation w.r.t time was observed and the strain energy loss calculated was utilised in 
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finding the material damping for Carbon fibre epoxy with riveted joints. Various 

simulations were performed in ANSYS and these results were utilised to calculate the loss 

factor, Rayleigh‘s damping constants and logarithmic decrement. 

Anand K.Mali, Tushar A.Jadhav discussed about “Noise Reduction of Centrifugal 

Blower Using Particle Damping”. International Engineering Research Journal Page No 

1930-1932 Sound basically is what we hear, but in practical way at loud levels it is the 

disturbance from equilibrium. The Centrifugal Blower generates a large amount of noise 

which causes a lot of disturbance and mental imbalance to the people working nearby. 

Hence the objective is reduction of noise near the working environment of the blower. It 

can be accomplished using acoustic materials, enclosures, silencers and mufflers. Particle 

damping is also one of the techniques which have a huge scope in reducing noise in 

components. The principle behind particle damping technique is removal of vibrations by 

absorbing the energy by the particles. In this work axial hole of an appropriate diameter is 

drilled to the main shaft and partially filled with metal particles. The vibration response of 

the blower with and without particle damping arrangement is measured to understand 

particle damping effectiveness. Index Terms – Centrifugal Blower, Decibel (dB), Particle 

damping, Sound Pressure Level (SPL). In order to study effect of particle damper on the 

noise of a centrifugal blower, full factorial experimental analysis has been performed. 

Readings were taken at different speeds and flow rates to analyse the effects of these 

parameters on noise of the blower. Considering the experimental analysis it is seen that 

there is a substantial reduction of noise for different speeds and flow rate. The noise is 

reduced by maximum 3 dB when 25% of shaft holes are filled with particles. The noise is 

reduced by maximum 2 dB when 50% of shaft holes are filled with particles. Considering 

the research done in particle damping, it can be said that a lot of applications can be carried 

forward with this technique. From the above works, it has been observed that much work 

is not reported so far to investigate the effect of vibrations in marine propeller blade. Hence 

an attempt was made to reduce the vibrations by using unconstrained damping treatment 

Carl Q.Howard discussed about “Recent Developments in Submarine Vibration 

Isolation and Noise Control Vibration isolation and noise control technologies are used in 

submarines on multiple systems and there are various reasons for employing these 

technologies. One of the principal reasons is to minimise the acoustic signature of the 

submarine so that it is difficult to detect. This paper contains descriptions of conventional 

and emerging noise and vibration isolation technologies that have and could be applied to 
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submarines. This paper contains a summary of some conventional technologies that are 

used for vibration isolation and noise control in submarines and marine applications. These 

technologies encompass passive, adaptive-passive, and fully active control methods. The 

development of new technologies for a future submarine is vital in order to gain an 

advantage (or at least maintain parity) in stealth capability with other submarines. As an 

example, the US Navy awarded General Dynamics Electric 

Mihir Khrdkar, Aditya Gandhi, Dhanashri Shevade, Meghali Gaikwad And 

Gautam Narwade discussed about “Noise Level Reduction in Machine Shop using Kaizen 

Techniques” International Journal of Current Engineering and Technology E-ISSN 2277 

– 4106, P-ISSN 2347 – 5161 Noise is simply the unwanted and displeasing sound that 

disrupts the activity or balance of human or animal life. The Automobile Industries are 

having several machineries that produce noise. The study in the paper is based to reduce 

the noise levels of these machines. The noise levels are identified and monitored for several 

machines and compared with its actual acceptable limits. The noise limits are be 

smoothened by certain techniques like providing silencers, sealing the air leakages, 

preventive maintenance schedule and once again noise level is measured for the machines 

to get the result of acceptable noise. This report summarizes best practice in noise and 

vibration measurement, prediction and assessment methodologies for noise reduction in 

the machine shop The aim of this research was to concentrate on high noise areas in the 

machining shop of the plant and suggest optimal measures to avoid it or reduce it by certain 

measures and techniques. The average noise level measured earlier was 96 dB. After 

proposing suitable kaizen techniques for noise reduction, the average noise level can be 

successfully decreased to an average 85 dB, which is about 12% of reduction. This 

provides a significant improvement in noise reduction. 

Pranali Khatake, P.T.Nitnaware, discussed about “Vibration mitigation using 

passive damper in machining” International Journal of Modern Engineering Research 

(IJMER) Vol. 3, Issue. 6, Nov - Dec. 2013 pp-3649-3652. This paper introduces vibration 

mitigation for boring bar with enhanced damping capability. The principle followed in this 

paper was to enhance the damping capability, minimizing the loss in static stiffness 

through implementation of passive damper. The newly designed tool has been compared 

to a conventional tool. The evaluation criteria were the dynamic characteristics, frequency 

and damping ratio, of the machining system, as well as the surface roughness of the 

machined work pieces an innovative method is proposed to reduce tool chatter and 



30 

 

enhance surface finish in boring operation. The results prove the passive damping 

technique has vast potential in the reduction of tool chatter. Passive dampers are also 

relatively cheaper than other damped boring bars. It is therefore concluded that passive 

damping has a good effect in improving surface finish in boring operation Significant 

improvement is observed between the results of surface finish obtained using boring bar 

without passive damper and boring bar with passive damper. 

Geremy Bourgois discussed about “Dual Mass Flywheel for Torsional Vibrations 

Damping Parametric study for application in heavy vehicle” Torsional vibrations is 

produced due to the pulsating load from the cylinders. These vibrations can cause 

crankshaft cracking, excessive bearing wear or failure, broken accessory drives, slapping 

of belts. Currently, engine designers have to downsize and downspeed the engine in order 

to satisfy European requirements in terms of CO2 emissions. These two actions make 

torsional vibrations more significant. Different technologies are used to reduce these 

vibrations, one of them is the Dual Mass Flywheel (DMF). DMF is a complex system 

containing rotational inertia, torsional stiffness and damping properties. A simplified 

mathematical model (2 degrees of freedom) has been developed in order to show the 

positive effect of a DMF on the powertrain. This work will focus on heavy vehicles. Two 

models have been made: one into Matlab and the other one in the open-source software 

Easydyn. The integration in Matlab is computed by a function based on an explicit Runge-

Kutta formula, whereas EasyDyn uses the Newmark method. Both of them give similar 

results. An optimization of the model has been realised into Matlab for the time and 

frequency domain. The optimization of the time domain is treated by local freegradient 

method using two objective functions (OFs): variation of the output torque and estimation 

of the power losses. For the frequency domain two other OFs are used: Reduction of the 

maximum value of the amplitude frequency response of the secondary flywheel and 

Reduction of the area under the curve of this frequency response. The optimization leads 

to similar results: increasing inertia, decreasing stiffness. Damping should be increased if 

high resonance peaks should be reduced. The effect of a more accurate torque expression 

on the output response is approached. At higher speeds (1500-2000 RPM), difference 

torque. 

From the above works, it has been observed that much work is not reported so far 

to investigate the effect of vibrations in marine propeller blade. Hence an attempt was 

made to reduce the vibrations by using unconstrained damping treatment 
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CHAPTER III 

3 MODAL ANALYSIS 

3.1  Introduction  

A Modal Analysis determines the vibration characteristics like Natural Frequency and 

Mode shapes of a structure or a machine component. It can also serve as a dynamic 

analysis, such as a Transient dynamic analysis, a Harmonic analysis, or a spectrum 

analysis. The natural frequency and mode shapes are important parameters in the design 

of a Structural and dynamic loading conditions. 

If there is damping in the structure or machine component, the system becomes a damped 

Modal analysis. For damped Modal system, the Natural frequencies and mode shapes 

become complex. A Modal analysis can be performed by using ANSYS, Samcef, 

ABAQUS solver  etc. 

In the present work, Modal analysis on free layer Damped Marine Propeller blade is done 

by using ANSYS Workbench and modelling is carried out in SolidWorks and CATIA. 

3.2  Modelling of Marine Propeller blade by SolidWorks 

3.2.1  Open the SolidWorks Application: 

SolidWorks is a solid modelling computer-aided design (CAD) and computer-aided 

engineering (CAE) computer program that runs on Microsoft Windows. SolidWorks is 

published by Dassault Systems. It delivers an intuitive experience in product design, 

simulation, publishing, data management, and environmental impact assessment. 

▪ Start menu > SoildWorks2013(Double click) 

 

 

 

 

https://en.wikipedia.org/wiki/Solid_modeling
https://en.wikipedia.org/wiki/Computer-aided_design
https://en.wikipedia.org/wiki/Computer-aided_engineering
https://en.wikipedia.org/wiki/Computer-aided_engineering
https://en.wikipedia.org/wiki/Computer_program
https://en.wikipedia.org/wiki/Microsoft_Windows
https://en.wikipedia.org/wiki/Dassault_Syst%C3%A8mes
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The SolidWorks window will open. 

 

Fig. 3.1 SolidWorks Interface   

3.2.2  Create the sketch 

Each assembly and Drawing you create is made from parts. To create a new part, Click 

New on the standard toolbar. The New SolidWorks Document dialogue box appears after 

that click the Tutorial tab and select the Part icon click Ok. 

▪ File > New > Part (Double click) 

The window while open the New Part as shown. 

 

Fig. 3.1 Opening New part 

Select the front plane from the left side of the window. Click on the sketch on the top tool 

bar. 
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▪ Front plane > sketch 

The window while draw the sketch as shown below. 

 

Fig. 3.3 Opening Sketch 

Draw an ellipse with major axis length is 25mm and minor axis length is 6mm for a 

damping layer of the propeller blade. 

▪ Features tab > Ellipse icon (Double-click) > Draw the ellipse (with origin as 

centre). 

▪ Features tab > Smart dimension > give the dimensions (major axis as 25mm and 

minor axis as 4mm). 

The window while give the dimensions of the Ellipse as shown below. 

 

Fig. 3.4 Draw the Sketch 

Select another plane on the drawn Ellipse and distance between the two planes is 

250mm. 
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▪ Features > References > Plane > Part 1> Front plane. 

Click on Features Tab Lofted based then select minor axis point and centre point on 

another plane. Finally generate propeller blade as per given dimensions. 

▪ Insert > features > Twist > 

Click on Insert<Features<twist. The Aerofoil shaped propeller blade is generated. 

3.2.3 Assembling by CATIA V5: 

 

Fig.3.5  

Click on CATIA V5>Start>mechanical design>part design 

File >Open>Browse the designed part 1>Import 

File>Open>Browse designed part 2>Import 

Select the part 2 surfaces >Copy >Paste in body 2 of the part 1 

Insert >Boolean operation>Remove >From part 1 to part 2 

Insert >Boolean operation >add >Part 2 to part  
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3.3 Modal Analysis in ANSYS Workbench 

3.3.1 Launching ANSYS Workbench 

The ANSYS installation has many packages included. For this problem, we will be using 

ANSYS Workbench. 

▪ Start menu > ANSYS 18.1 > Workbench 18.1 

The Workbench Project Window will open.

 

Fig. 3. 

3.3.2 Pre-processing (Setting up the model) 

Our analysis is a modal analysis. It can be found in the Toolbox on the left, and needs to 

be added to the project schematic by either double clicking it or dragging it into the pane. 
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Fig. 3. 

The modal component and all of its modules will be created. They outline the steps that 

are required to complete a finite element analysis. 

▪ Engineering Data module is used to define the material properties. 

▪ Geometry module opens the Design Modeller application, which can be used to 

import CAD models from other software like SolidWorks or to sketch a new 2D 

or 3D geometry. 

▪ Model, Setup, Solution and Results opens the Mechanical application, which can 

be used to set up and solve the simulation (includes meshing, load and boundary 

condition applications, solving and results). 

3.3.3 Engineering Data 

Double-click Engineering Data, Where you can add a new material by defining a new 

material entry for AA6063, Natural Rubber, Neoprene etc. in Outline pane. 

 We want to define material is Isotropic elastic in Toolbox pane. 

We also give value of the properties like Density, Poisson ratio, Young’s Modulus etc. 

of that particular material in Properties pane. 

▪ Outline pane > click here to add a new material > type “AA6063” 

▪ Toolbox pane > Linear Elastic >  Isotropic Elasticity (Double Click) 
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Fig. 3. 

In Properties pane, boxes will appear in colour are indicate values of the properties that 

entered before continuing. In this case, we entered the Young’s modulus (in Pa), Poisson 

Ratio and Density (in Kg/m3 ). Repeat the procedure same for adding different materials. 

After that, exit Engineering Data by closing the tab at the top of the window and return to 

the main project. 

3.3.4  Geometry 

By default, ANSYS Workbench will analyse the problem in 3D. in this project, we are 

doing Modal analysis on the propeller blade which was designed by using SolidWorks and 

CATIA softwares.  

▪ Modal system > Geometry (Right Click) > Import New Geometry > Browse 

> Select the Propeller Blade part in STEP File format( which was already 

created in SolidWorks Software. 
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Fig. 3. 

 

3.3.5  Model 

Enter the Mechanical application by double clicking on the Model module, At this point, 

Workbench should attach the geometry that was made in Solid Works Software and make 

it available in mechanical application, where we will complete the configuration of this 

simulation and solve it. 

▪ Modal system > Model module > Edit (Double click) 

 

 

Fig. 3. 
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At this point, we will notice that Mechanical application has two panes on the left. One is 

Outline pane and other one is Details pane. The Outline pane contains a tree with all the 

settings you add to the model. The Details pane will provide options for each of these 

settings that you can change. 

 

Fig. 3. 

You may also specify a material for each geometrical body in our simulation. 

▪ Details pane > Material > Assignment (which was already added in Engineering 

Data). 
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Similar to the ANSYS MAPDL, Meshing will discretise the model into Elements and 

Nodes that will resemble the geometry. The arrangement of this elements and nodes is 

known as a mesh. The mesh can have an effect on the result of the analysis. A finer mesh 

typically gives more accurate results,, but at the cost of higher computational requirements. 

Other mesh factors such as shape, element order and distribution, may also influence the 

accuracy of results. 

We will set all the elements to the elements to be triangles, as this will conform to the 

Geometry. The sizing will be set to 0.5mm in this tutorial however this will not be small 

enough to make your simulation accurate enough. You should change this number yourself 

to evaluate the effect of element size on your results. 

▪ Outline pane > Model > (right-click) > Insert > Method > Click on body.  

▪ Details pane > Scope > Geometry > Apply. 

▪ Details pane > Definition > Method > “triangles”. 

▪ Outline pane > Model > Mesh (right-click) > Insert > Sizing > Click on body.  

▪ Details pane > Sizing > Size Function> Adaptive > apply. 

▪ Details pane > Sizing > relevance centre > Medium. 

▪ Details pane > Definition > Element Size > Type “0.5”. 

▪ Outline pane > Model > Mesh (right-click) > Generate Mesh. 
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Workbench provides different selection tools that will allow you to select vertices, edges, 

faces and bodies. To switch between these, use the buttons at the top of the screen. you 

also have the option to interact directly with the geometry or the mesh by using the 

dropdown menu for select type. 

The next step is to apply necessary boundary conditions. The geometry propeller blade all 

degree of freedom on surface are taken. It was denoted with blue flag. This condition 

prevents the movement of the surface in space. 

▪ Outline pane > Model > Modal > Fixed support. 

▪ Details pane > Scope > Geometry > Select the face. 

▪ Details pane > Definition > Type > Fixed support.  

 

 

Fig.2 

We can influence the computational time of the analysis, when a range of frequencies or 

number of mode shapes is specified. The type of solver and the the solution method in 

program ANSYS is selected automatically. For this modal analysis we taken the number 

of modes as six modes. 

▪ Outline pane > Solution (right-click) > Deformation > Total Deformation 1 

▪ Details pane > definition > type > total deformation. 

▪ Details pane > definition > mode > 1 



44 

 

▪ Details pane > definition > mode > 2 

▪ Details pane > definition > mode > 3 

▪ Details pane > definition > mode > 4 

▪ Details pane > definition > mode > 5 

▪ Details pane > definition > mode > 6 

▪ Standard toolbar > Solve (right-click). 

Then results window will appear 

 

Fig. 3. 

 

Mode 1 2 3 4 5 6 

Frequency [Hz] 148.54 498.72 9110.96 1760.7 3169.6 3178.9 

Table. 3. 
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CHAPTER IV 

4 RESULTS AND DISCUSSIONS 

4.1 Introduction 

 The present study focused on vibration control over marine propeller blade. The 

study is carried with modelling using SOLID WORKS 2013*64 and CATIA V5 and modal 

analysis is done using ANSYS WORKBENCH 18.1. For this study with different 

polymers used as damping material such as Natural, Neoprene and Nitrile rubber.  

 The test is conducted to find out the chemical composition of AA6063 material. 

This material is used as base material of a marine propeller blade. The following results 

are obtained. 

4.2 TEST RESULTS 

Element Fe Si Mn Zn Cu Ti Cr Mg Al 

Percentage 0.425 0.445 0.036 0.022 0.087 0.015 0.031 0.487 98.42 

Table. 4.1 Composition of AA6063 

4.3 MODELLING: 

Modelling is done with SOLID WORKS 2013 and CATIAV5. 

4.3.1  SOLID WORKS:  

1. Open solid works 2013*64.Click on file > New > Part > Ok. 

2. Select Front plane > Sketch > Ellipse command. 

3. Draw an ellipse with major axis length is 25mm and minor axis length is 6mm for 

a damping layer of the propeller blade. 

4. Select another plane on the drawn ellipse<point and distance between the planes is 

250mm. 

5. Click on Features<Lofted based then select minor axis point and centre point on 

another plane. Finally generate propeller blade as per given dimensions. 

6. Click on Insert<Features<twist. The Aerofoil shaped propeller blade is generated. 
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7. Again design another propeller blade with dimensions of major axis length is 

25mm and minor axis length is 4mm as a base part of the propeller blade. 

 

Fig. 4.1 designed propeller blade in solid works  

4.3.2 CATIA V5: 

1. The designed two propeller blades (base part and damping layer part) are imported 

in CATIA V5 for assembling. 

2. Click on tools<Boolean Operations<Remove. 

3. Remove base part from damping layer part. 

4. Then Click on tools <Boolean Operations <Assemble. 

5. Assemble the base part to the damping layer part. 

 

Fig. 4.2 Assembled propeller blade by using CATIA V5 
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4.4 MODAL ANALYSIS: 

 A Modal analysis determines the vibration natural frequencies and 

corresponding mode shapes of a structure. It can serve as a starting point for other types 

of analysis by detecting unconstrained bodies in contact analysis. The natural frequencies 

and mode shapes are important parameters in the design of a structure for a dynamic 

loading condition. 

1. Add a modal analysis template by dragging the template from the tool box in to the 

project schematic or by double clicking the template in the tool box. 

2. Load the geometry by right clicking on the geometry cell and choosing import 

geometry. 

3. View the geometry by right clicking on model cell. Alternatively, you can right 

click the set up cell and select edit. This step will launch mechanical application. 

4. In the mechanical application window, complete modal analysis using the 

mechanical applications tools and features. See modal analysis in the mechanical 

application help for more information on conducting a modal analysis in the 

mechanical application.  

4.4.1 Generic Steps to Solving any Problem in ANSYS: 

 Solving any problem analytically, we need to define Solution 

domain, physical domain, boundary conditions and the physical properties. Then we solve 

the problem and present the results. Below describes the processes in terminology slightly 

more attune to the software. 

Engineering Data: Define the materials for existed design model. This includes mechanical 

properties like young’s modulus, density and Poisson’s ratio. 

Geometry: construct a two or three dimensional representation of the object to be modelled 

or import modelled design by any other soft wares like solid works or catia etc.. 

Generate mesh: At this stage ANSYS understands the makeup of the part. Then discretize 

the part into finite pieces. 

Apply Loads: once the design is over then we need to apply boundary conditions such as 

fix the geometry at one end. 
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Obtain solution: This is actually a step , because ANSYS needs to understand within what 

state (steady state , transient state etc..)the problem must be solved. 

Present the Results: After the solution has been done , there are many ways to show the 

results , choose from the options such as graphs ,tables etc... 

DEFAULT MESH: 

1.AA6063: 

ELEMENTS:2824 

 

NODES:6045 

 

4.5 MODAL ANALYSIS : 

AA6063 Frequency table: 

S.NO MODE FREQUENCIES(Hz) 

1 1 148.54 

2 2 489.72 

3 3 910.96 

4 4 1760.7 

5 5 1369.6 

6 6 1378.9 

Table. 4.2 Frequencies of AA6063 Propeller blade at different Modes 
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Fig. 4.3 AA6063  
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Fig. 4.5 
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     Table. 4.3 Comparison of Frequencies  
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5.CONCLUSIONS 

 The Modal analysis was carried on treated and untreated Marine 

propeller blades successfully and conclusions are drawn as follows: 

1. From the Modal analysis it is observed that maximum deformation obtained with 

the untreated propeller blade made of Aluminium alloy compared with treated 

blades. 

2. The natural frequencies of aluminium propeller blade were found 41.36% more 

than the damping layer applied propeller blade. 

3. The natural frequency of aluminium propeller blade at mode 2 is 489.72Hz. 

4. The natural frequency of damping layer of Natural rubber 40 applied propeller 

blade at mode 2 is 315.42Hz. 

5. The natural frequency of damping layer of Nitrile rubber 50 applied propeller blade 

at mode 2 is 287.15Hz. 

6. The natural frequency of damping layer of Neoprene rubber 60 applied propeller 

blade at mode 2 is 324.65Hz. 

7. Finally the natural frequency of damping layer of Nitrile rubber 50 applied 

propeller blade at mode is 287.15Hz which is better than among  9 damping 

materials and aluminium. 
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